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1 Introduction 

Applications for the Lifelong Learning Programme in the 2012 Call for proposals must be made using 
the eForm. 

The purpose of this document is to provide guidance on the technical aspects of completing and 
submitting the eForm. It does not replace the document Instructions for completing the Application 
Form and its attachments which must be read and consulted by applicants for all guidance on the 
content of the application form, the application procedure and the rules that must be respected. This 
document can be found on the 2012 LLP Call for Proposals webpage: 

 http://eacea.ec.europa.eu/llp/funding/2012/call_lifelong_learning_2012.php 

Please note that the terms 'eForm', 'form', 'application form' and 'online application form' are used 
interchangeably throughout this guide. 

You are strongly advised not to leave the preparation and submission of your application form until 
the last days before the deadline for applications 

 

Please read all of this User Guide before beginning your application 

2 Technical Requirements & Considerations 

The eForm is an interactive PDF form that requires Adobe Reader software to be installed on your 
computer for you to be able to complete and submit it.  

The retrieval and submission of the form are ‘online’ activities but completion of the form and its 
validation are ‘offline’ activities. This is explained in more detail in the process overview below. 

Adobe Reader 
The minimum version i.e. lowest version of Adobe Reader that you must have installed on your 
computer is version 8.1.5. You may also use a higher version than this e.g. 8.2, 9.0, 9.1 etc. If you 
have a lower version than 8.1.5, you will not be able to complete and submit the eForm. 

Follow the link below to be directed to Adobe's website to download the software free of charge or to 
upgrade your existing copy of the software. If you do not have administrator rights on your computer 
this activity may require the intervention of your IT department. You will need to specify your 
operating system before the download can commence. 

http://get.adobe.com/reader/otherversions/ 

If you are using Adobe Acrobat (Standard) or Adobe Acrobat Professional, the version must likewise 
be 8.1.5 or higher. 

The screenshots in this User Guide are based on version 8.1.6 of Adobe Reader. 
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You can check the system requirements for Adobe Reader – i.e. the minimum required specification of 
your computer – through the following link: 

http://www.adobe.com/uk/products/reader/systemreqs/ 

Security settings in some versions of Adobe Reader and Adobe Acrobat 
If you are using a version of Adobe Reader or Adobe Acrobat that incorporates Enhanced Security, it 
is possible that the enhanced security settings will block the submission of your eForm. The involved 
versions of Adobe Reader and Adobe Acrobat are: 

• 8.2 or any higher version 8 than this (including any sub-versions e.g. 8.2.1, 8.2.2 etc); 

• 9.3 or any higher version 9 than this (and including any sub-versions e.g. 9.3.1, 9.4.2 etc; 

• any version X (including any sub-versions e.g. 10.0.1) 

The disabling of the Enhanced Security is performed from the following Adobe Reader menu path: 

 Edit > Preferences > Security (Enhanced) 

Uncheck the box Enable Enhanced Security and click OK. Once the submission has been performed 
you can re-enable the Enhanced Security. For more detailed instructions (including screenshots),  
please refer to the relevant 'Known Issue' on the following webpage: 

http://eacea.ec.europa.eu/eforms/index_en.php#issues 

Here you will also find instructions on how to leave Enhanced Security enabled but identify your 
eForm as a trusted item (stored in a ‘privileged location’) so that its submission is not blocked. 
 
Internet Connection & Browser software 
You will require an internet connection and standard browser software to retrieve and submit the 
online application form. 
 
Test eForm 
A test eForm is available on the EACEA eForm home page: 
 

http://eacea.ec.europa.eu/eforms/index_en.php 

The form contains a small number of questions and functions. It has been designed to help applicants 
understand how the main fields in the eForm work and also to ensure that their own software and 
internet connection allow an application form to be submitted. It is NOT mandatory to use this form; it 
is provided as a help tool for applicants who are using electronic submission for the first time. 

Advice for Macintosh Users 
The eForm can only be opened and completed using Adobe Reader or one of the Adobe Acrobat 
products. It is not possible to open and work with the eForm using the Mac Preview viewer. 

Please therefore ensure that if your default viewer is set as Mac Preview, you nonetheless open the 
eForm with one of the Adobe products mentioned above. This advice applies to both the download of 
the form – if you try to open it before downloading – and to the opening of the form for its general 
completion and submission. For more detailed advice, please visit the ‘Known Issues’ section of the 
EACEA eForm home page: 

 http://eacea.ec.europa.eu/eforms/index_en.php#issues 
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3 The Online Application Process – Overview 

(i) You download the eForm from the agency website, saving it to your own computer or local 
network drive. Do not try to fill in the form directly on the website. The form can only be 
filled in once you have saved it to your local computing environment.  

(ii) You complete the eForm on your own computer (as an ‘offline’ document). You do not need 
to be connected to the internet for this and no connection to the EACEA website or any 
Commission server is required. Completion of the form includes the attachment of the 
annexes.  

(iii) You validate the form (on your own computer) to ensure that it is ready for submission. 
(iv) You connect to the internet and press the submit button to submit your form. You do not need 

to be connected to the EACEA website or to any particular webpage – this connection to the 
Agency’s server happens automatically. (The submission process includes a mandatory save 
both before and after the submission. These save operations are instigated by the form itself. 
This is explained in detail in section 8.) 

(v) If the submission is successful, a submission number will be automatically generated and 
added to your form.  

(vi) You print your form. 
(vii) An email acknowledging receipt of your form is automatically sent to the email address that 

you entered for the contact person in Part A.2 of the Applicant Organisation or Part A.2 of the 
Coordinating Organisation where the latter is different from the former.  

4 Working with the eForm 

4.1 Download the eForm from EACEA 

A link to a read-only copy of the form can be found on the EACEA eForm home page:  

http://eacea.ec.europa.eu/eforms/index_en.php 

Save the form to your local computer or network drive, respecting the following filename convention: 

action_country code_acronym of your project_AppForm.pdf 

You can now open, edit, save, close, print etc the file in the same way you would any other document 
you had saved or created on your own computer. 

4.2 Adobe Reader – a brief introduction to some key features of the pdf form 

 

 

 

Activate the 
Highlight Fields 

facility 

VERY 
USEFUL! 

Attach facility  

DO NOT USE! 
The eForm has its 
own attach facility 

Activate  
Page Thumbnails 

(see below) 

Adobe Help for 
common features 

Navigation panel, 
on the left-hand 
side of the screen 
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Toolbar 

From the Tools menu you can customise your toolbar e.g. you can add the Save button if it is not 
already displayed. There are also various display and navigation options that you can add. 

 

 

Explained here are some of the commonly used display and navigation options: 

 

 

 

 

 

Toolbar 

Customise 
toolbar 

selection menu 
(partial view) 

Zoom In 
(reduce 

image size) 

Zoom Out 
(enlarge 

image size) 

Fit form to width 
of screen and 
scroll across page 
boundaries 

Turn on ‘Page 
View’ – 

 1 whole page 
displayed  at a 

time  

Move 
back 1 
page  

Move 
forward 1 

page  



  [Version 1] 

 Page 7 of 26  

Page Thumbnails 

If you activate the Page Thumbnails option, a new panel is opened up on the lefthand side of the 
screen. It contains miniature previews (‘thumbnails’) of each page: 

 

Zoom in / Zoom out 

To rapidly zoom in or out, press CTRL on your keyboard and move the scroll wheel on your mouse: 

  Scroll up  to zoom out, increasing the size of the image 
  Scroll down   to zoom in, decreasing the size of the image 

4.3 eForm completion 

The eForm is an interactive PDF form that contains form fields that are either selected from a 
restricted list or filled in using free text: 

Click inside a text field to enter data. 
Click to select options from e.g. dropdown menus, radio buttons and checkboxes. 
Press Tab to move forward one field or Shift+Tab to move backward one field. 
Point and click with the mouse to select a specific field. 

 

• Use the 
thumbnails to 
jump to different 
areas of the form.  

 
• A box outlined in 

red indicates 
where you are in 
the document. 

 
• Right click on the 

panel to access 
options to enlarge 
or reduce the 
thumbnails.  

Red box 
indicating 

your 
location   
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4.4 Mandatory, optional and calculated fields 

Field Type Characteristics Examples 

Mandatory  
Field label is 
accompanied by an 
asterisk *      

Optional Field label has no asterisk 

           

Calculated 
automatically 

Field contains diagonal 
grey lines.    

How to highlight mandatory fields 

Click on the purple button  in the navigation panel and this will activate the Document message 
bar which incorporates the Highlight Fields feature. 

 

Mandatory fields –  red border and a light blue background 
Optional fields –  light blue background (and a black border when you hover the cursor over them). 

 

 
 

     

Please note: if any mandatory field remains incomplete the eForm will not validate successfully and it 
will not be possible to submit your form. Where a numerical field is mandatory but you have no value 
to enter e.g. in Part B.4, please make sure you enter a zero to indicate your null value. 

Once you have activated the highlighting you can click the purple button  again to remove the 
Document message bar (and maximise the display of your form). 

Unhighlighted fields Highlighted fields 

Click on the Highlight Fields button and all 
mandatory and optional fields will gain 
highlighting that makes them easier to identify 
(and easier to differentiate from one another). 
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4.5 Saving your form 

To save your form, click on the Save button on the toolbar or select Save from the File menu or press 
CTRL and S. 

 

Please ensure that you save your form on a regular basis. If you encounter a problem in your local 
computing environment and your form or your computer crashes, the Adobe Reader auto-recovery 
function will only restore your form to the point of the most recent save. 

4.6 Entering Dates and Numbers 

Please respect the following rules when entering dates and numbers on the form: 

 Rule Example 
Numbers Only whole numbers are accepted. Do not use 

any separators such as commas or dots. 50000 not 50,000 

Dates All date fields are in the format dd/mm/yyyy 01/10/2013 
Telephone numbers No rules -  this is a free text field - 

4.7 Using the Add and Delete buttons (eForm tables) 

Some fields or groups / blocks of fields are required to be completed more than once allowing you to 
build up a 'table' of information e.g. the list of organisations involved in your project or a series of  
priorities or objectives. Whenever you need to insert a new 'blank' field or add rows to a table, you will 
do this by using the Add buttons. 

These buttons are coloured green. Click on them to add the desired new field or table row. 

 
 

 
 

Once you have added a field or row, the delete facility – an orange-coloured button containing an 'x' – 
appears so that you can delete the field, block of fields or table row concerned (and its contents!). 

Click here to add a new 
row 

Click here to 
delete a row 
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4.8 Formatting 

If you enter formatted content into the form e.g. through copy-and-paste from other document sources, 
the eForm will remove the formatting and plain text only will be pasted into the form. 

Please do not copy bullet points into your form. The formatting of some bullets can trigger the 
requirement to download add-ons to your Adobe Reader software (so that it can handle those bullets). 
You may use dashes to represent bullets in a list of points or items. 

4.9 Character Limits 

The free text fields in the eForm have character limits that restrict the amount of text you can enter. 
These limits include both characters AND spaces. If you try to enter more characters than the limit 
allows the form will simply restrict the text to the predefined limit. Most word processing packages 
have a 'count' tool that can help you respect the limits.  

For the major fields, the limits are displayed in the headings and sub-headings of the eForm. For other 
fields, please consult the following table: 

Part Field Character Limit 
Project Title 300 

Cover Page 
Project Acronym (see section 5.1) 7 
Full name of the organisation 62 
Name in latin characters 62 
Acronym 62 
Erasmus University Charter number 100 
Department / Faculty 40 
Street  57 
Street Number 5 
Postcode 12 
Town 60 
Internet address 60 
Telephone 1 and Telephone 2 60 
Fax 60 
Title 25 
Family name 62 
First name 62 
E-mail address 100 

A 

Role in the organisation 32 
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5 Guidance for specific Parts of the form 

5.1 Cover Page 

Important! 

Please ensure that you complete ALL the fields of the Cover Page (page 1) BEFORE going on to 
complete the rest of the form! 

This is because the selections that you make, dictate how the rest of the form behaves. For example, 
the options that are presented in Part B.2, LLP Objectives and Priorities addressed are dependent upon 
the sub-programme, action and, where applicable, sub-action that you selected. 

If, after filling in parts of your form, you change your choice of Action / Sub-action – or even just re-
select the same Action / Sub-action from the dropdown menu – you will lose data that you have 
entered elsewhere in the form. 

The Project acronym field is limited to 7 characters. If you require an acronym that is longer than this, 
please include the full acronym of your project at the start of your Project title and then enter the first 
7 characters of the acronym in the Project acronym field. 

Tooltip for long descriptions 

Where a description overflows the menu box, hover your cursor over the menu item to display the full 
description in a tooltip: 

 
 

Advice for Third Country partner(s) participation ONLY 

If there is third country participation in your application, check the relevant checkbox that is found 
just before the start of Part A (it only displays in the form once you have completed the Cover Page): 

 

This automatically generates in the eForm a Third Country Budget summary for you to complete. It 
also results in differently presented controls for the ‘Add organisation’ function (see below for 
details). 

If you subsequently uncheck this box – whether intentionally or by mistake – the form will prompt 
you to confirm the operation. If you confirm it, the form will delete all third country partner details 
you had entered and will delete the Third Country Budget summary. There is no ‘undo’ facility.  

Only confirm the operation if you want to delete all trace of third country participation from your 
application! 
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5.2 Part A – Participating Organisations 

For each organisation in your consortium you must complete a part A.  

The fields for the Applicant Organisation are already present in the form that you downloaded from 
the Agency’s website. The fields / rows for all other partner organisation must be generated by you by 
using the ‘Add organisation’ button in the ‘Partner Controls’ section of the form (this is described 
below and varies according to whether you have Third Country participation or not). 

5.2 (i) Recording the Applicant Organisation and, where applicable, the Coordinating Organisation 

This guidance is for ALL APPLICANTS 

The ‘Role in the application’ field and the ‘Partner number’ field are not fields that you can select or 
modify. Instead, their values are allocated automatically by the form. This automatic allocation works 
as follows:  

o P1 is fixed as the Applicant Organisation. 

 
o If the Coordinating Organisation is different from the Applicant Organisation, as 

indicated by your checkbox selection… 

 
…then, when you add a second organisation, P2 is automatically allocated the role of 
Coordinating Organisation: 

 
o If the Coordinating Organisation and the Applicant Organisation are the same, as 

indicated by your checkbox selection… 

 
…then P2 is automatically allocated the role of Partner organisation: 

 
(This assumes that if your application has Third Country participation, you record 
your partners before recording the Third Country partners. See also below.) 

For the remaining consortium partners that you need to record: 

• if your application does not include Third Country participation go to step 5.2 (ii) of this 
guide; 

• if your application does include Third Country participation go to step 5.2 (iii) of this guide. 
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5.2 (ii) Recording other partners for applications which do NOT include third country participation 

Further partner organisations ‘rows’ are added using the previously-mentioned button in the ‘Partner 
Controls’ section of the form: 

 

Once the Applicant and Coordinating Organisations have been recorded – whether as 1 organisation or 
2 – all subsequent organisations are automatically allocated the role of Partner.  

As you record your organisation details, a summary table – ‘List of partner organisations’ – is built up 
automatically in the form: 

 

This table is protected and cannot be used to add or delete organisations. This can only be done 
through the green Add and orange Delete buttons described earlier. 

5.2 (iii) Recording partners for applications which INCLUDE third country participation 

Further partner organisations ‘rows’ are added using the previously-mentioned ‘Partner Controls’ 
section of the form. When you have signalled that there is third country participation in your 
application, the ‘Partner Controls’ section of the form displays as follows: 

 

 

 

 

Click on the ‘Add organisation’ button to generate the required fields / rows in your eForm.  

Once the Applicant and Coordinating Organisations have been recorded – whether as 1 organisation or 
2 – all subsequent organisations that you add are automatically allocated the role of either ‘Partner’ or 
‘Third Country’:  

• The partners that you add will automatically be allocated the role Partner; 

• The third countries that you add will automatically be allocated the role Third Country. 

Enter the number for the 
number of partners that you 

want to add 

Enter the number for the 
number of Third Country 

partners that you want to add 

Enter the number for the 
number of partners that you 
want to add. 
 

Then click on the ‘Add 
organisation’ button to generate 
the required fields / rows. 
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As you record your organisation details, a summary table – ‘List of partner organisations’ – is built up 
automatically in the form: 

 

This table is protected and cannot be used to add or delete organisations. This can only be done 
through the green Add and orange Delete buttons described earlier. 
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Important! 

Partner numbering (when there is Third Country participation) 
When you add any of the types of partner organisation using the ‘Add organisation’ button, the partner 
numbering is automatically allocated by the form. This allocation works as follows: 

All partner organisations that are NOT from Third Countries automatically appear in the form and 
are listed BEFORE i.e. earlier in the form than all Third Country partners. The form automatically 
pushes the Third Country partners to the end of Part A and the end of the list thus giving them the highest 
partner numbers. 

Consequently, if you add some partners and some Third Country partners and then at a later time add an 
additional partner (non-Third Country), the partner numbers of the Third Country partners will be 
automatically (dynamically) increased. This is because the additional partner, despite having been added later, 
will be inserted into the form and the partner list before the Third Country partners. This is illustrated (for the 
partner list table) in the following screenshots. 

In this first screenshot the Third Country partners have been allocated the partner numbers P4 and P5: 

      
Subsequently, an additional partner based in Paris – boxed in red below – has been added: 

      
The partner number P4 has been automatically reallocated to the Paris-based partner and the Third Country 
partners have been reallocated partner numbers P5 and P6. 

To avoid this automatic renumbering, you are strongly advised to only enter your Third Country partners once 
you have fully recorded all your other partners. 

Please ensure that if you do encounter this automatic renumbering, you take account of the new numbering in 
any other documents that you are preparing as part of the application package. For example, partner numbers 
are required to be recorded in the Description of the Project and the Detailed budget tables and Workplan. All 
partner numbers used within these documents must be coherent with the partner numbers allocated to 
your partners in the eForm! 
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Further Part A guidance for ALL applications 

• The field ‘Internet address’ in Part A.1 relates to the organisation’s website address. 

• The field A.3 – details of the Legal Representative – is only required to be completed for the 
Applicant Organisation. Consequently, it only appears in the form for the Applicant 
Organisation (P1). For all subsequent organisations, the field A.3 is omitted and only fields 
A.1 and A.2 are presented for completion. 

• The Registered address you enter in Part A.1 is automatically copied to Parts A.2 and A.3. 
Check the relevant checkbox in order to write different address details in Parts A.2 or A.3. 

Tip 
When selecting a country value, instead of deploying the dropdown menu, enter the initial letter of the 
country into the field. This will take you to the first country in the list that begins with that letter. 
Press the same letter again to bring up the next country. For example, entering the letter ‘s’ three times 
in succession would bring up: 

Slovakia 
then Slovenia 
then Spain.  

The up and down arrow keys on the keyboard can also be used to navigate the list – without deploying 
the dropdown menu – once an initial selection has been made. 

5.3 Part B – Description of the Project 

B.2 LLP Objectives and Priorities addressed 

If the description for the code that you have selected is not fully visible, please refer as necessary to 
the full descriptions found in the Call documentation: 

http://ec.europa.eu/education/llp/doc/call12/prior_en.pdf 

Depending on the sub-programme, action and, where applicable, sub-action that you selected on the 
Cover Page, some codes and checkboxes may be pre-selected for you in this section e.g. where there is 
only one priority on offer for a particular action or sub-action or where a linkage is mandatory. 

B.3.1 Total duration of the project 

The start dates and maximum durations vary according to the sub-programme and action. Details of 
the different start dates and maximum durations are found in the document Instructions for completing 
the Application Form and its attachments. 

You must record the duration start and end dates before going on to complete the Summary Budget in 
Part B.4. The duration that you record affects the budgetary rules that are applied in the Summary 
Budget.  
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B.4 Summary Budget and, where applicable, Third Country Budget 

If a budgetary rule has been broken, you will see red font in your table. Please ensure that all 
budgetary rules are respected and that you have no red figures or error messages in the budget table.  

         

All fields in the budget tables are mandatory. If you have no value to enter, do not leave the field blank 
but enter a zero. 
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6 Attaching Documents to your eForm 

The following mandatory annexes, which are a formal part of your grant application, must be attached 
to your eForm: 

Description of the project 
Declaration of Honour By Legal Representative of Applicant Organisation; 
Detailed budget tables & Workplan/Workpackages summary chart; 
Legal Entity Form (Applicant Organisation only). 

Please use the following filenames for your attachments and respect the cited format restrictions: 

Annex Filename Required Format 

Description of the 
project 

action_country code_acronym of your 
project_Desc doc or docx 

Declaration of Honour action_country code_acronym of your 
project_DecHon pdf, tiff or jpeg 

Detailed budget tables 
& Workplan 

action_country code_acronym of your 
project_Bud xls or xlsx  

Legal Entity Form action_country code_acronym of your 
project_LEF pdf, tiff or jpeg  

Example filename 

For a Leonardo da Vinci Multilateral Project with the acronym ACRO that is being completed by an 
Applicant Organisation based in Belgium, the budget annex would be named: 

  Leonardo MP_BE_ACRO_Bud 

(This example filename does not include the extension details – .xls or .xlsx) 

Attachment size limitation 

There is a limit to the total (combined) size of your attachments. This is 5MB. If you receive a 
message advising you that the total size of documents exceeds the maximum allowed, please reduce 
the size of the image-based documents e.g. by reducing their resolution. 
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To carry out the attach function, click on the relevant Attach a document button and a window will 
pop up enabling you to browse, locate and select the file you wish to attach: 
 

  
 

 

 

 

 

Once a file has been successfully attached, the filename is displayed and the Attach a document  
button is replaced by a Delete this document button and a View this document button: 

 
 
Please note: your ability to view a document that you have attached is subject to the security settings 
on your computer. Please consult your IT department if you need to change the security settings in 
order to view an attached document. This phenomenon does not affect the document itself which 
retains its content and integrity. 

 

Click on the ‘Open’ 
button to attach the 
selected file to your 
application. 
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7 Validation of your eForm 

The Validate Form button appears at the bottom right of every page of the form.  

 

It is recommended that you do not validate your form until you have finished completing it as 
validation slightly alters the look of the form. 

When you are ready, click on the button and various checks will be automatically performed to 
ascertain whether your form is ready for submission. For example, the validation will verify that all 
mandatory fields have been completed, that no rules have been broken in the budget table and that all 
the mandatory attachments are present. 

If there are any errors present, the total number of them will be listed on the last page of your form. If 
there are any budget or attachment errors these will be itemised separately in the same list:  

 

The errors themselves will be highlighted in pink. In the example that follows the mandatory field 
‘Summary of the project’ has not been completed: 
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When you validate, an additional button – the Go to next error button – appears next to the Validate 
form button.  

 

Use this button to jump from error to error in your form. The function starts with the error nearest the 
top of the form i.e. nearest to Page 1 and descends the form moving to the next error with each click. 

Please note the following: 

• When you fix the errors that are highlighted, the Errors list is not dynamically updated. It is 
only updated i.e. refreshed when you perform another validation. 

• The Go to next error function works best when you fix errors one by one, following the top-
to-bottom sequence used by the Go to next error button. If you fix errors out of sequence e.g. 
fix an error further down the form, the Go to next error function will still follow the original 
sequence of errors reported by the validation.  

• If you have fixed errors out of sequence, you are recommended to perform a fresh validation 
so that the errors you have fixed are removed from the sequence (and you would then start 
again from the error nearest the top of the form). 

• If you prefer, you can simply do a visual search for the pink errors in your form. If you do 
this, it is recommended that you first turn off the highlighting for mandatory fields (see 
Section 4.4). You may find the thumbnail view a useful aid to quickly detecting the pink 
highlighted fields (see Section 4.2). 

Whichever method you use, fix the errors that are present and validate your form again. If all errors 
have been resolved you will see the following pop-up message: 

 

Until your form validates successfully the Submit button is disabled and it will not be possible to 
submit your form. The Submit button turns from grey to green when validation has been carried out 
successfully. 
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8 Submission of your eForm 

On the final page of the form is the Submit this form button. Once your form has been successfully 
validated the button is enabled (as confirmed by its green colour). Click on this button to launch the 
submission. 

 

The following message will appear: 

 

If for any reason you do not want to continue, you may click No and carry out the submission at a later 
time. The submission process will end. Once you click Yes your form will be locked and it will no 
longer be possible to modify its content, including the attachments. 

8.1 The mandatory save BEFORE submission 

If you click Yes, the next step of the submission process is a mandatory save. The following message 
appears: 

 

When you click OK, the form triggers a Save As operation. You will see the classic Save As window as 
appears in the screenshot which follows.  

(Please note: this screenshot is simply an example of the Save As window. The window that you see, 
will reflect the filename and directory name that you have been using.)  
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You must now perform the Save As by clicking on the Save button. 

Very Important! 

You must NOT change the filename of your eForm. 
You must keep the same filename that the file had when you began the submission operation!  

Click Yes when you are asked if you want to replace the existing file: 

 

8.2 Submission 

Depending upon your security settings, the following pop-up window may now appear: 

       

Example screenshot 
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If the window appears, click on the Allow button in order to proceed with the submission. 

When the submission is complete you will see a pop-up message similar to the one that follows: 

        

Click ‘OK’. 

8.3 The mandatory save AFTER submission 

When you click OK, the form triggers another Save As operation. This is so that you cannot 
mistakenly close the form without saving (and so lose the submission number!).  

Once again you will see the classic Save As window appear: 

 

You must now perform the Save As by clicking on the Save button. 

Very Important! 

You must NOT change the filename of your eForm. 
You must keep the same filename that the file had when you began the submission operation!  

 

Example screenshot 
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Click Yes when you are asked if you want to replace the existing file: 

 

When you click ‘Yes’, the submission number is automatically added to the ‘Submission number’ 
box:  

 
It is also inserted into the footer of your form. 

The form has also been saved and this save included the submission number. 

Your submitted form is now ‘locked’. That is to say, it has been converted to a read-only document: 
changes cannot be made to it and it cannot be re-submitted.  

As part of the submission process, an email message acknowledging receipt of your eForm is 
automatically sent to the email address you entered for the contact person of the Applicant 
Organisation or, where applicable, the contact person of the Coordinating Organisation (where the 
latter is different from the former). 

9 Printing your eForm  

The eForm can be printed using Adobe Reader’s standard menu-driven print function. The Print 
button is found on the tool bar, or the Print menu can be selected from the File menu.  

 

10 How to obtain Technical assistance – eForm HelpDesk 

If this User Guide does not provide answers to all of the technical questions or problems you 
encounter in completing the application form, a telephone and email HelpDesk service is available to 
assist you further: 

eForm Technical HelpDesk: +32 229 90705 
eacea-helpdesk@ec.europa.eu 

Monday to Thursday 08:30 to 17:30 (CET/CEST) 
Fridays 08:30 to 17:00 (CET/CEST) 

Excluding public holidays 
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Should you experience what you believe to be a significant technical issue with the eForm it will be 
worth checking the LLP website since, in the event of a general technical problem, an update bulletin 
would be posted.  

You may also visit the Agency’s dedicated eForm webpage which contains the latest versions of all 
published forms along with the Test eForm (mentioned in section 2) and other items of information: 

 http://eacea.ec.europa.eu/eforms/index_en.php 

Non-technical assistance 

If you require assistance with a query or problem that is not technical in nature, please do not contact 
the eForm Technical Helpdesk. The eForm Technical Helpdesk team are only authorised and trained 
to help applicants who are encountering technical problems. 

Please refer instead to the funding opportunities webpage of the programme/action that you are 
applying for. On this webpage you will find details of how to obtain non-technical assistance e.g. 
assistance with questions on: 

• the content of the eForm; 
• the application process including instructions for providing the backup copy; 
• the rules of the programme / Call that you are applying for. 

Generally speaking, the funding opportunities webpage will include the mailbox address of the 
programme team that is responsible for the programme/action that you are applying for. The page will 
also contain documentation that may already provide an answer to your non-technical question e.g. a 
Programme Guide or Instructions for Applicants document or a link to an in-country Helpdesk which 
can help you. If you cannot find the answer to your question, please contact the mailbox of the 
programme team cited on the funding opportunities webpage. 

The following table provides some examples of technical and non-technical questions. 

Technical Questions 
(handled by the eForm Technical Helpdesk) 

Non-technical Questions 
(handled by the programme team) 

I can’t download the form. What is required to be entered for the field Status? 

A dropdown list isn’t working. Why isn’t country A in the dropdown list? 

I can’t attach my budget form (or 
other annexe/attachment). 

I need help with completing my budget form. 

How does the synchronisation of fields work? Why is this field mandatory? 

I can’t delete a table row that I have entered. 

Our project has more than one coordinator. 
What should I do? 
What is the minimum / maximum number of partners that 
is allowed? 

My form freezes/crashes. 
What documents are required for the paper 
backup and where do I send it? 

My form is working slowly. I need more characters for my answer! 

My form won’t validate. What do you mean by the term ‘acronym’? 

My form won’t submit. Where are the templates for the attachments and 
additional documents? 

I think there is a bug in the form. What should I enter in the form for my project start and 
end dates? 

 


